# Contents

How to use this guide................................................................................................................................. 5
NVivo and qualitative research..................................................................................................................... 5
Support for your chosen methodology ....................................................................................................... 5
Understanding NVivo editions..................................................................................................................... 6
NVivo key terms ......................................................................................................................................... 6
Explore the sample project .......................................................................................................................... 7
How do I approach my research project? .................................................................................................... 7
Install and activate NVivo for Windows ...................................................................................................... 8
Supported Operating Systems ................................................................................................................... 8
System requirements .................................................................................................................................. 8
Install NVivo................................................................................................................................................ 9
Start NVivo and activate your license ......................................................................................................... 9
The NVivo Start screen................................................................................................................................ 10
Create a new project.................................................................................................................................... 10
The NVivo Workspace .............................................................................................................................. 11
Working with the ribbon ............................................................................................................................. 12
Navigation View .......................................................................................................................................... 12
List View .................................................................................................................................................... 13
Detail View ................................................................................................................................................ 13
Customize your workspace.......................................................................................................................... 14
Early steps .................................................................................................................................................. 14
Sharing projects in a team ............................................................................................................................ 15
Preparing for teamwork............................................................................................................................... 16
Bring your material into NVivo .................................................................................................................. 17
Interviews, articles and other documents .................................................................................................... 17
Survey results and other datasets ............................................................................................................... 18
Audio and video ........................................................................................................................................ 19
Create your own transcripts ....................................................................................................................... 19
Get your materials transcribed .................................................................................................................. 20
Photos and other images ............................................................................................................................ 20
Web pages, social media and YouTube videos ............................................................................................ 21
Collect data on mobile devices (with Evernote) .......................................................................................... 22
Import from OneNote .................................................................................................................................. 22
Create externals for the things you can’t import ......................................................................................... 23
Bibliographical data .................................................................................................................................. 23
Source classifications .................................................................................................................................. 23
Literature reviews in NVivo – keeping everything in one place .................................................................... 23
Understand nodes, cases and coding........................................................................................................... 24
Nodes ......................................................................................................................................................... 24
Cases ......................................................................................................................................................... 25
Relationships .............................................................................................................................................. 25
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with cases</td>
<td>28</td>
</tr>
<tr>
<td>Creating cases</td>
<td>28</td>
</tr>
<tr>
<td>Understanding classifications and attributes</td>
<td>28</td>
</tr>
<tr>
<td>Classifying cases</td>
<td>29</td>
</tr>
<tr>
<td>Work with classification sheets</td>
<td>29</td>
</tr>
<tr>
<td>Exploring people, places and other cases</td>
<td>30</td>
</tr>
<tr>
<td>Coding your source materials</td>
<td>31</td>
</tr>
<tr>
<td>Code at new or existing nodes</td>
<td>31</td>
</tr>
<tr>
<td>Make a node from a selected word</td>
<td>31</td>
</tr>
<tr>
<td>Approaches to coding</td>
<td>32</td>
</tr>
<tr>
<td>See what you have coded</td>
<td>33</td>
</tr>
<tr>
<td>Open a node to explore the references</td>
<td>34</td>
</tr>
<tr>
<td>Automatic coding techniques</td>
<td>35</td>
</tr>
<tr>
<td>Quick coding with Text Search queries</td>
<td>35</td>
</tr>
<tr>
<td>Quick coding based on style or structure</td>
<td>35</td>
</tr>
<tr>
<td>Automatically detect and code themes or sentiment</td>
<td>35</td>
</tr>
<tr>
<td>Coding tips</td>
<td>36</td>
</tr>
<tr>
<td>Memos, annotations and links</td>
<td>37</td>
</tr>
<tr>
<td>Creating a linked memo</td>
<td>37</td>
</tr>
<tr>
<td>Adding an annotation to selected content</td>
<td>37</td>
</tr>
<tr>
<td>Adding a see also link</td>
<td>37</td>
</tr>
<tr>
<td>Memos - a crucial piece of the analytical puzzle</td>
<td>38</td>
</tr>
<tr>
<td>Summarize your data in framework matrices</td>
<td>39</td>
</tr>
<tr>
<td>Bring it all together with queries</td>
<td>40</td>
</tr>
<tr>
<td>Use queries for text analysis</td>
<td>40</td>
</tr>
<tr>
<td>Use queries to explore your coding</td>
<td>41</td>
</tr>
<tr>
<td>Making the most of queries</td>
<td>42</td>
</tr>
<tr>
<td>Visualize your project</td>
<td>43</td>
</tr>
<tr>
<td>Generating diagrams</td>
<td>43</td>
</tr>
<tr>
<td>Building maps</td>
<td>46</td>
</tr>
<tr>
<td>Create reports and extracts</td>
<td>48</td>
</tr>
<tr>
<td>Automated insights</td>
<td>49</td>
</tr>
<tr>
<td>Auto code themes</td>
<td>50</td>
</tr>
<tr>
<td>Auto code sentiment</td>
<td>51</td>
</tr>
<tr>
<td>Social Network Analysis</td>
<td>52</td>
</tr>
<tr>
<td>Working with relationships</td>
<td>52</td>
</tr>
<tr>
<td>Generating sociograms</td>
<td>52</td>
</tr>
</tbody>
</table>
How to use this guide

This guide will help you to get up and running with NVivo 11 Plus for Windows. It provides step-by-step procedures for fundamental tasks, and suggests ideas and techniques to help you move forward with your project.

For more information about working with NVivo refer to:

- NVivo Help—click the File tab, then click Help and then click NVivo Help.
- The QSR website (www.qsrinternational.com)—access video tutorials, the QSR forum, FAQs, training and support.
- The NVivo blog covering issues, trends and best practice in qualitative and mixed methods research.
- The NVivo Users Group on LinkedIn or follow the QSR Facebook page or @QSRint on Twitter.

NVivo and qualitative research

Many qualitative researchers are interested in evaluating, interpreting and explaining social phenomena. They analyze data from interviews, surveys, field notes, web pages and journal articles—and they work in a range of sectors; from social science and education to healthcare and business.

Support for your chosen methodology

NVivo doesn’t favor a particular methodology. It is designed to facilitate common qualitative techniques for organizing, analyzing and sharing data—no matter what method you use.

Researchers usually adopt a qualitative methodology to suit their research question. For example, a social scientist wanting to develop new concepts or hypotheses may take a ‘grounded theory’ approach. A health researcher looking for ways to improve policy or program design might use ‘evaluation methods’.
Understanding NVivo editions

There are three editions of NVivo 11 for Windows software: NVivo Starter, NVivo Pro and NVivo Plus. Each edition features a different level of functionality to support a range of projects and research needs.

This guide describes NVivo Plus—a sophisticated research tool with everything you need for analyzing all forms of unstructured data.

NVivo Plus offers all the functionality of NVivo Pro, plus, innovative social network analysis tools and research automation features.

In NVivo Plus you can:

• Gain quick insights from large amounts of data by automatically identifying themes and sentiment
• Automatically create social network visualizations from social media data or your own project data

You can open any NVivo 11 for Windows project in any of the editions, and you can upgrade to a different edition at any time.

Visit the QSR Website for a detailed comparison of the features available in each edition.

NVivo key terms

As you work through this guide you’ll be introduced to a number of key concepts but here are some basic terms to get you started:

• **Sources** are your research materials including documents, PDFs, datasets, audio, video, pictures, memos and framework matrices.

• **Source classifications** let you record information about your sources—for example, bibliographical data.

• **Coding** is the process of gathering material by topic, theme or case. For example, selecting a paragraph about water quality and coding it at the theme node ‘water quality’.

• **Nodes** are containers for your coding that represent themes, topics or other concepts—they let you gather related material in one place so that you can look for emerging patterns and ideas.

• **Cases** are containers for your coding that represent your ‘units of observation’—for example, people, places, organizations or artifacts.

• **Case classifications** allow you to record information about cases—for example, demographic data about people.
Explore the sample project

If you prefer ‘hands on’ learning you may like to explore and work with the NVivo sample project—Environmental Change Down East. This is a ‘real-world’ project that illustrates the main features of the product. You can use the sample data to experiment with queries, visualizations and other analysis tools.

You can access the sample project from the NVivo Start screen.

How do I approach my research project?

There is no agreed ‘industry standard’ or prescribed process for approaching a qualitative project but there are some recognized strategies and steps you can take—you’ll find some suggestions as you work through this guide. It can help to understand that qualitative research is an iterative process—for example, this picture shows a path you might take when exploring a particular theme:

Remember that NVivo can help you to manage, explore and find patterns in your data but it cannot replace your analytical expertise.
Install and activate NVivo for Windows

Before installing, make sure that your computer meets the hardware and software requirements.

Supported Operating Systems

- Microsoft Windows 10 (32-bit and 64-bit)
- Microsoft Windows 8 (32-bit and 64-bit)
- Microsoft Windows 7 (32-bit and 64-bit)

System requirements

<table>
<thead>
<tr>
<th>Minimum Requirements</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.2 GHz single-core processor (32-bit), 1.4 GHz single-core processor (64-bit)</td>
<td>2.0 GHz dual-core processor or faster</td>
</tr>
<tr>
<td>2 GB RAM or more</td>
<td>4 GB RAM or more</td>
</tr>
<tr>
<td>1024 x 768 screen resolution</td>
<td>1680 x 1050 screen resolution or higher</td>
</tr>
<tr>
<td>Approximately 5 GB of available hard-disk space—or more depending on data storage needs</td>
<td>Approximately 8 GB of available hard-disk space—or more depending on data storage needs</td>
</tr>
<tr>
<td>Internet connection</td>
<td>Internet Explorer 8 or later, Google Chrome 44 or later</td>
</tr>
</tbody>
</table>

Additional requirements for NVivo add-ons

- For NCapture: Internet Explorer 10 or later, or Google Chrome 44 or later
- For the NVivo Add-In for OneNote: Microsoft OneNote (2007 or 2010) and Microsoft Word (2007 or 2010)
Install NVivo

You must have administrator permissions for the computer on which you are installing the software.
If you want to work with .mov and .qt video files you should install the 32-bit version of NVivo.
When you double-click the NVivo installer file—the installation process starts automatically. Follow the steps to:

• Install any prerequisite components. You may be asked to restart your machine—on restart the installation will continue automatically.
• Accept the NVivo license agreement.
• Confirm the location of NVivo program files and choose to include an NVivo icon on your desktop.
• Choose the supplementary add-ons that you want to install. NCapture is a browser extension that allows you to gather material from the web. The NVivo Add-In for OneNote allows you to bring your OneNote content into NVivo.

Note: If you work with audio and video files, you may need to install additional codecs—for more information, refer to the FAQs area of the QSR website.

Start NVivo and activate your license

You need to activate your NVivo license—this is a simple and secure process that ensures valid licenses are used to operate the software.
If you are using a trial version of the software, you do not need to enter a license key, but you must activate the trial before you can use NVivo.
To start NVivo double-click the NVivo 11 icon on your desktop then follow the steps:

1. In the Welcome to NVivo dialog box, enter your license key (or select the option for a free trial and choose an edition), and then click Next.
2. In the License Activation dialog box, enter your details and click Activate—if you are connected to the Internet, you can activate immediately.
3. In the User Profile dialog box, enter the initials you want to use to identify your work in NVivo projects. This is especially useful if you are working in a team—refer to the NVivo Help for more information about teamwork in projects.

When you click OK, the NVivo Start screen is displayed.
Create a new project

1. On the NVivo Start screen, click Blank Project.
2. Enter a name for this project and add a description.
3. Click the Browse button and choose a location to save your project (you can work locally or on a network). NVivo projects are saved as .nvp files.

If your organization has purchased NVivo Server, in the Save as type list, select NVivo Server Projects. Refer to the NVivo Help for more information.
The NVivo Workspace

The NVivo workspace provides easy access to all your project material.

- **The ribbon helps you to locate all NVivo commands.**
- **Navigation View** lets you organize your material into folders.
- **Check the Status bar to see what is happening in your project**
- **Work with your sources, nodes or other project items in Detail View.**
- **Undock to work with your content in a separate window.**
- **Access Help**

See the contents of a folder in **List View.**
When you open items in a folder, they display in **Detail View.**
**Working with the ribbon**

Commands are organized into logical groups on the ribbon, collected together under tabs. Each tab relates to a type of activity, such as creating new project items or analyzing your source materials.

- **The File tab** for managing projects, printing and setting application options.
- **Quick Access Toolbar** - customize the commands to suit the way you work.
- **Tabs for accessing commands related to an activity**

---

**Navigation View**

Navigation View helps you to organize and easily access all of the items in NVivo:

- Click a button to see all the folders in the group.
- Click to see folders for all project items.
- Drag the handle down to make more room.
- Right-click to add folders to organize your research materials.
- Hover over a command to see a description.
List View

When you select a folder in Navigation View, its contents are displayed in List View. In this view, you can add new items, open existing items and edit item properties. This List View displays the contents of a folder:

- Double-click an item to open it
- Drag the boundary to resize columns
- Sort the list by clicking on column headings
- See the assigned color

Right-click on items to access a shortcut menu

Display an optional column for classification

Detail View

When you open an item from List View the content is displayed in Detail View. This is an example of an interview opened in Detail View:

- Open multiple items and move through them using tabs
- Right-click a tab to undock Detail View and work in a separate window
- Click to switch to edit-mode
Customize your workspace

You can arrange the workspace to suit the way you like to work. For example, you can minimize the ribbon or use the options on the View tab to:

- Hide Navigation View to make more room (ALT+F1).
- Show, hide or re-order the columns displayed in List View.
- Display Detail View on the bottom of the screen — this is particularly useful when working with queries.
- Undock Detail View into a separate window.

Refer to the NVivo Help for detailed instructions.

Early steps

Before you import your source material or get started with coding, you could take some time to:

- **Prepare for auto coding** — if you have consistently structured sources like focus groups or interviews (that ask the same set of questions), you can apply paragraph styles to facilitate auto coding in NVivo. Refer to the NVivo Help for more information about how to do this.

- **Create a memo (journal)** and state your research questions and record your goals. Why are you doing the project? What is it about? What do you expect to find and why? What biases do you bring to the project? Update the journal regularly to stay focused and to show the evolution of your project.

- **Make a mind map** to brainstorm your initial ideas, starting point and any assumptions.

- **Make a concept map** to show the relationships or patterns you expect to find in your data based on prior experience or preliminary reading — copy and paste it into your journal.

- **Make a concept map** to show the relationships or patterns you expect to find in your data based on prior experience or preliminary reading — copy and paste it into your journal.
Sharing projects in a team

Many projects involve multiple researchers working together—NVivo provides two ways to approach collaboration:

• Share projects using NVivo Server 11—everyone in your team can work on the same project at the same time. They can code, annotate and link source content and have immediate access to the changes made by other team members.

You can work on standalone projects or connect to NVivo Server to access server projects

• Work in copies of a project and merge them into a master project at appropriate intervals—making use of user profiles to track changes. You can find out more about this in the NVivo Help.

Team members can work on the same project using different editions of the NVivo software (NVivo Starter, NVivo Pro and NVivo Plus)—but some editions do not support all of the features and project items available in other editions. Any NVivo 11 for Windows project can be opened in any edition, however some project items cannot be accessed.

If your team is using NVivo Starter, at least one member of the team needs NVivo Pro or NVivo Plus to be able to merge projects.
Preparing for teamwork

Whether you work with NVivo Server or collaborate in a standalone project you might want to consider the following:

• Appoint a team leader who will keep the team on track and make final coding decisions.
• Have regular team meetings to discuss interpretations, address issues and assign tasks—record the outcomes in a memo.
• Have each team member keep a memo to record their progress, including any hunches, suggestions or questions—you could also do this in a single ‘teamwork journal’.
• Early on, have multiple team members code the same collection of sources, then compare coding (using coding stripes or a coding comparison query)—this can help ensure a consistent approach.
• To start with, make a thematic node hierarchy for each team member. After team discussion, you can refine, merge and reorganize.
• Aim for a clear thematic node structure and use descriptions (in node properties) to make the purpose of theme and case nodes clear for all team members.
Bring your material into NVivo

Sources are the materials that you want to analyze in NVivo—they can include articles, interviews, survey results, audio/video recordings, pictures, web pages or social media content.

To import sources, use the options on the Data tab:

Interviews, articles and other documents

You can import interviews, journal articles, reports and any other Word documents or PDFs:

Select text, such as this paragraph, and code the text at a node

In PDFs you can also select regions of the page, like this image, and code the region at a node

Add annotations or ‘see also’ links to selected text (or to selected regions of the page)
Survey results and other datasets

A dataset contains structured data arranged in records (rows) and fields (columns)—for example, a dataset could contain the responses to a survey.

You can create a new dataset source in NVivo by:

- Importing data from a spreadsheet, text file or database table.
- Importing an NCapture file that contains social media data.
- Connecting to SurveyMonkey and bringing in your survey results.

You cannot edit the contents of a dataset once it is imported. Before importing spreadsheets, text files or database tables, you should prepare your data and consider how you want to use it in NVivo—refer to the NVivo Help for detailed instructions.
Audio and video

You can import audio and video in a wide range of formats—refer to the NVivo Help for a detailed list. You can play and analyze an audio or video source in Detail View:

- Code directly on the timeline
- Add ‘see also’ links and annotations to the timeline or to the transcript
- Work with imported videos or videos from YouTube
- Select content and code it at a node

When recording audio or video it’s a good idea to reduce background noise, have one person speak at a time and place the microphone in a good position.

Before you import audio or video material, consider any editing requirements. For example, if you have hours of video footage, you may want to edit it down to a manageable size—you cannot do this editing in NVivo. When you import media files you can choose to store them inside or outside your project—if you have many large videos, we recommend you store them outside the project so that software performance is not compromised.

Create your own transcripts

You can transcribe your media files in NVivo. In ‘transcribe mode’, you can play and pause the media—transcribing as you listen and NVivo will automatically add new rows and timestamps. To support this process, you can also use a foot pedal and keyboard shortcuts.

If you have already transcribed the material in a Word document or text file (with correctly formatted timestamps) you can import the transcript into the audio or video source.

When it’s time to code the material, you can code the media directly (on the timeline) or you can code the transcript.

Refer to the NVivo Help for more information about creating transcripts.
Get your materials transcribed

Creating your own transcripts may bring you closer to your data but it can also be labor intensive and time consuming. Instead, you can have your media files professionally transcribed using TranscribeMe—an integrated transcription service that offers:

- Fast turnaround times
- Security and confidentiality
- Competitive transcription rates
- High quality, accurate transcripts in an 'NVivo-ready' format
- Automatic and seamless download of transcripts into your NVivo project

You can order and purchase transcripts without leaving the NVivo application:

Select audio or video sources to be transcribed → Get a price and place an order → Media files are uploaded to TranscribeMe → Completed transcripts are downloaded

If you don’t already have an account with TranscribeMe, you will be prompted to create one.

Transcripts are synchronized with your audio and video sources.

TranscribeMe provide transcriptions in a variety of languages—you can check the available languages at the time you place your order.

Photos and other images

You can import photos or other images and analyze them in NVivo—refer to the NVivo Help for a detailed list of supported image formats.

A picture source consists of a picture and a text log:

Code directly on the picture

Create a log to describe the picture (or just selected regions)
Web pages, social media and YouTube videos

NCapture is a browser extension that lets you clip web pages and import them as PDF sources into your NVivo project.

Save a web page as an NCapture file

Import it as a PDF source

You can also capture social media conversations (from platforms like Facebook or Twitter)—and store them as PDF or dataset sources. Having content in a dataset means you can sort, filter and auto code—for example, you could gather Tweets by location. Visualize your Twitter dataset as a sociogram showing how users are connected by retweets and mentions. Refer to “Generating sociograms” on page 52 for more information.

Store social media content in a dataset

Using NCapture, you can also capture YouTube videos and then work with them in NVivo. You may also want to import any comments as a dataset.

For detailed instructions about installing and using NCapture, refer to the NCapture Help.
Collect data on mobile devices (with Evernote)

When working in the field, you may want to collect data on a mobile device. For example, you could use your smartphone or tablet to:

- Record audio or video interviews
- Snap photos of participants, white-board diagrams or research settings
- Clip web pages and gather articles online
- Make notes to record field observations, ideas and insights

You can use Evernote (a popular cloud-based app) to gather and organize this data when you’re out and about. When you’re back at your desk, you can connect to your Evernote account (from within NVivo) and import the material.

Refer to the NVivo Help for more information about importing content from Evernote.

Import from OneNote

If you use OneNote 2010, you can use the NVivo Add-In for OneNote to export your pages (to a .nvoz file) and bring them into NVivo.

Refer to the NVivo Help for detailed instructions.
Create externals for the things you can’t import

Externals are ‘proxies’ for the material you cannot import into NVivo such as books, or physical artifacts. You can create an external source (that looks like a document) and summarize the content of the item—for example, you might enter key points from a PowerPoint presentation or summarize the chapters in a book.

You can then code or annotate this content. If the external represents a file on your computer, you can create a link to the file and easily open it from within NVivo.

Bibliographical data

If you have conducted a literature review using a bibliographical application like EndNote, Mendeley, RefWorks or Zotero—you can export the data from the application as an EndNote XML file or RIS file and import it into NVivo. The records are added as sources in your project and the bibliographical details are stored as ‘source classifications’ and attribute values.

Source classifications

You can also record bibliographical information by ‘classifying’ your sources in NVivo—when you are ready to write up your findings, you can export this data to your reference management tool and use its features to insert citations and format the references. Refer to the NVivo Help for more information about classifying your sources and working with bibliographical data.

Literature reviews in NVivo – keeping everything in one place

Using NVivo for your literature review can be a great way to learn the software and get started with a project. You can bring in your journal articles and:

• Organize them in a source folder called ‘Literature’.

• Code each article to gather material by theme—you might also want to make nodes for ‘statistics’, ‘good quotes’ and ‘definitions’.

• Annotate as you read, marking content for follow-up or further exploration.

• Use memos to describe the key themes and critique the articles.

• Use source classifications to assign attributes like publication date and author (you can also import these from reference management software like Endnote). Then use queries to find everything an author wrote about a theme or everything that was written before a certain date.

• Use a Word Frequency query to see what common terms are being used.

• Use a Matrix Coding query to find gaps in the literature—what themes are already heavily discussed and which provide scope for further exploration?
Understand nodes, cases, relationships and coding

You code your sources to gather material about a topic and store it in a container called a node. As you explore your sources, you select content and code it at a node.

When you open any type of node you can see all the references in one place—allowing you to reflect on the data, develop your ideas, compare attitudes and discover patterns. Refer to “Open a node to explore the references” on page 34 for more information.

Nodes

Nodes represent themes, topics, concepts, ideas, opinions or experiences. For example, you could create the node water quality and as you explore your sources (documents, PDFs, datasets, audio, video or pictures) you could code all references to water quality at the node.
Cases

Cases represent your units of observation—a case might be a person, place, site, organization or any other entity.

Cases are a special type of node because you can classify them then assign attributes (variables) such as age, gender or location. As you code content at cases and theme nodes, you can use queries to ask meaningful questions—How do young women respond to the challenge of climate change? Do their attitudes differ from those of older women?

Relationships

Relationships are where you can record statements or hunches you have developed about how items in your project are connected. For example, Anna ‘employs’ Ken and industrial waste ‘impacts’ water quality.

As you work through your sources, code information at relationship nodes that support or demonstrate the connection. For example, code text that is evidence of marine dumping affecting water quality at the marine dumping ‘impacts’ water quality relationship. You can then open the relationship node and explore the evidence you have gathered.

When you create relationships between case nodes, you can generate sociograms to visualize and analyze the connections between your cases. Refer to “Generating sociograms on page 52 for more information.
Working with nodes

Creating nodes
If you already know what themes you are looking for (based on your literature review, for example), you can create and organize your nodes before you start coding.

It’s easy to create nodes using commands on the Ribbon—on the Create tab, in the Nodes group, click Node.

If you want to pre-design your node structure, you can quickly create nodes using a mind map. Refer to “Building maps” on page 46 for more information.

Alternatively, if you want to see what themes emerge from your sources, you can create nodes as you code. Refer to “Code at new or existing nodes” on page 31 for more information.

Creating node hierarchies
Organizing your nodes into a hierarchy is an important part of the analytical process, helping you to refine your thoughts and draw connections between themes.

Add ‘child’ nodes (sub-nodes) under an existing node to create a hierarchy. You can also drag & drop or cut & paste nodes to move them around.

As you code at the node, you can see the number of sources and references increase.

When the parent node has ‘aggregation’ turned on, any content coded at the child nodes is rolled-up into the parent node.

See the NVivo Help for more information about customizing and displaying columns.
Build an efficient node hierarchy

- Keep node names short and pertinent.
- Make sure a node only appears once in the whole hierarchy.
- Try not to combine concepts in a node. For example, instead of coding some text at skeptical attitudes about government policy, code it at both the node skeptical attitudes and government policy. Use queries to gather your coded content coded at multiple nodes.
- Try not to force nodes into a hierarchy—if a node is not related to any other concept then leave it at the top level.
- Try not to nest more than 3 levels deep if you can help it.
- Prune your nodes regularly. Merge, reorganize, rename. See the NVivo Help for more information.
- Create a memo and make notes about why you structured your nodes a particular way. If you change the structure later, explain why in your memo.
Working with cases

Creating cases
You can create cases manually just like creating nodes. If you want to get the most out of your cases, consider classifying them and assigning attribute values.

In List View, you can select a source then on the Create tab, in the Items group, click Create as cases—this action will create a case and code the entire source at the case node.

If you have a large number of cases, NVivo provides ways to speed up the process. For example, you could automatically create cases when you import sources, and you could then import descriptive attributes from a spreadsheet or text file. See the NVivo Help for more information.

Understanding classifications and attributes
Use classifications to record descriptive information, like demographic details, about the cases in your project.
For example, if you have interviewed people in a particular community, you may want to collect information about their age, gender and occupation—and compare their responses based on these attributes.

To work with case classifications and attributes, you need to:

• Create a classification—for example, Person. You could also create classifications for different types of people, like students or teachers.
• Define attributes for the classification—for example, age group and gender.
• Create a case then classify it and assign relevant attributes values to it—for example, 60-69 and female.
• Code content to the case. Coding is how the source content is assigned to the case.

A case for each participant with all their content coded at the case node
The case nodes are classified (as Person in this example) and the attributes are recorded in a classification sheet
You can then use coding queries to gather content based on demographic attributes
Classifying cases

1. In List View, select the case you want to classify.
2. On the Home tab, in the Item group, click Properties.
3. Click the Attribute Values tab then assign a classification.
4. Click the arrow in the Value field to select a value for each attribute.

If you have demographic data about your cases in a spreadsheet you can import this data and automatically classify the case nodes in your project. See the NVivo Help for more information.

Work with classification sheets

Classification sheets provide an overview of the items in a particular classification. For example, if you have created cases for interview respondents and classified them as Person, you can double-click on the classification to quickly see the spread of your respondents:
Exploring people, places and other cases

NVivo provides tools for exploring the cases in your project, for example, you could:

- Use a matrix coding query to compare your respondent’s comments based on demographic attributes:

```
<table>
<thead>
<tr>
<th></th>
<th>A: Person:Commercial Fishing = Yes</th>
<th>B: Person:Commercial Fishing = No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1: Positive</td>
<td>4</td>
<td>19</td>
</tr>
<tr>
<td>2: Mixed</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>3: Negative</td>
<td>31</td>
<td>127</td>
</tr>
</tbody>
</table>
```

- Create a chart to check the demographic spread of your respondents:

![Chart showing demographic spread of respondents]

- After reviewing the content in a case node—make a concept map to visualize a participant’s perceptions and to ‘tell their story’.
- Generate a comparison diagram to compare coding between two cases.
- Make a memo to record your thoughts and insights about the case.
Coding your source materials
You code your source materials to gather material about a topic and store it in nodes and cases.

Code at new or existing nodes
1. Open a source in Detail View.
2. Select the content that you want to code. The content you can select depends on the type of source you are working with.

There are a few different ways to code. Try:
- Dragging the selected content to an existing node or case in List View.
- Accessing the right-click menu—select Code Selection then choose an option.
- Clicking options on the ribbon—on the Analyze tab, in the Coding group, choose a coding option.
- Using keyboard shortcuts—refer to the NVivo Help for more information about shortcuts.
- Using the Quick Coding bar (at the bottom of Detail View) to code content at existing nodes. You can create nodes, cases and relationships here too.

Make a node from a selected word
Sometimes you want to stay as close as possible to your participants’ own words. Use text taken directly from the source content to create and code at new nodes.

Select the text content you want to code then on the Analyze tab, in the Coding group, click Code In Vivo. The selected word or phrase is used to name the node and is (at the same time) coded at the node.
Approaches to coding

The way you approach coding depends on your methodology and research design but here are some ideas to get started:

- Start with ‘broad-brush’ coding to organize the material into broad topic areas (you can use Text Search queries to help with this)—then explore the theme node for each topic and do more detailed coding. For example, gather all the content about water quality and then explore the theme node looking for interesting perceptions, contradictions or assumptions.

- Or, you could get straight into detailed coding (making theme or case nodes as you need them) and then, later on, combine and group your nodes into related categories.

- As you reflect on a piece of content, think about these different types of coding:
  - Topic coding—What is the topic being discussed? For example, water quality, real estate development, tourism and so on.
  - Analytical coding—What is this content really about? Why is it interesting? Consider the meaning in context and express new ideas about the data. For example, ideals vs reality, tension between developers and residents.
  - Descriptive or case coding—Who is speaking? What place, organization or other entity is being observed?
See what you have coded

To see what has been coded in a source, you can use options on the ribbon.

- Turn on coding highlight—on the View tab in the Coding group, click Highlight, and then select a highlight option.
- Turn on coding stripes—on the View tab in the Coding group, click Coding Stripes, and then select an option. Coding stripes are displayed on the right side of the source.

Coding stripes can reflect the colors you have assigned to nodes—refer to the NVivo Help for more information about using color in your project.
Open a node to explore the references

You can open a node to see related references gathered in one place. In Navigation View, click Nodes then in List View, double-click the node you want to explore.

The node is opened in Detail View.

You can see what sources were coded and click on the link to open a source

You can set options to display more or less of the context around a reference

The Reference tab is displayed by default, it shows all the text content coded at the node

Click on these other tabs to see content from pictures, PDFs, audio, video and datasets

You can select content and 'code on' to new nodes
Automatic coding techniques

Quick coding with Text Search queries
You can use NVivo queries to automatically code your sources based on the words or phrases they contain. This can be a useful starting point for reviewing your data. For example, you could run a Text Search query on the word *fish* and automatically code all occurrences. You can search for exact words, phrases or similar concepts. For example, search for *fish* and find *trout*, *mullet*, and *crab*.

To create a Text Search query—on the **Query** tab, in the **Create** group, click **Text Search**. Refer to the **NVivo Help** for more information about the options you can choose.

Quick coding based on style or structure
Interview documents can be auto coded based on style or structure—for example, if participants are all asked the same set of questions, you can auto code the interviews based on paragraph styles.

Datasets can be quickly coded based on their structure too—for example, you can auto code a survey dataset to gather all the answers to each question.

Automatically detect and code themes or sentiment
Automated Insights lets you quickly identify broad themes and sentiment in your sources. Use the Auto Code Wizard to perform approximate broad-brush coding of large volumes of text, which you can then review and refine.

Automated insights is particularly useful if you have a very short time to form a broad conclusion. For example, you may want to report on the preliminary findings of a public consultation or get an impression of sentiment about a brand.

Refer to “Automated insights” on page 49 for more information.
Coding tips

- Remember that you can code content at multiple nodes and cases. For example, you could code Barbara’s comment at all of the theme nodes shown here, as well as the case node Barbara:

- If you code all your interviews like this, then you can use queries to gather your material in different combinations. For example, show me:
  - All the content coded at water quality and development
  - Negative attitudes about water quality
  - What women said about water quality

- If you find an interesting phrase or theme in one interview, you can use a Text Search query to see if it appears in the other interviews—and automatically code the content.

- After exploring and coding a source, take some time to reflect on what you have discovered. Run a report to see which theme or case nodes have been used most often—how do these nodes relate to each other? Make a project map to explore the relationships and record your thoughts in a memo.

- You may not need to exhaustively code all your material. For example, if after working through twelve interviews you are not finding any new themes or ideas—you may have reached ‘saturation’. You could use Text Search queries to do some broad-brush coding in subsequent interviews.
**Memos, annotations and links**

Memos are an integral part of the research process—and can be a great starting point when you come to writing-up your project. Memos are like documents and they can be linked to sources or theme and case nodes. Annotating are like scribbled notes in the margin—they let you record comments, reminders or observations about specific content in a source or node.

Use ‘see also’ links to draw connections between items in your project. For example, you can use ‘see also’ links to point out contradictions, follow evidence or show a sequence of events.

**Creating a linked memo**

To create a memo that is linked to a source or node:

1. Select the source, theme node or case node in List View or open it in Detail View.
2. On the **Analyze** tab, in the **Links** group, click **Memo Link**, and then click **Link to New Memo**. The **New Memo** dialog box opens.
3. Enter a name for the memo.
4. (Optional) Enter a description of the memo.
5. Click **OK**. The memo is opened in edit mode and you can enter the content.

**Adding an annotation to selected content**

To create an annotation:

1. Select the content you want to annotate.
2. On the **Analyze** tab, in the **Annotations** group, click **New Annotation**.
3. In the **Annotations** tab at the bottom of Detail View, enter the annotation.

![Any annotated text shows in blue](image)

**Adding a see also link**

To add a see also link from content to another source:

1. Select the content you want to link from.
2. On the **Analyze** tab, in the **Links** group, click **See Also Link**, and then click **New See Also Link**.
Memos - a crucial piece of the analytical puzzle

You can use memos to tell the story of your project—from your early ideas and assumptions to fully-fledged insights about a topic, person, or event. Use them to ‘talk to yourself’ as you make sense of your data.

Tracking your analytical process with memos can help you to increase the transparency and reliability of your findings. With your process recorded in memos, you can easily demonstrate the evolution of a theory or quickly call up data that supports client questions.

Memos are quite ‘free form’ in NVivo and our innovative users (from the LinkedIn NVivo Users Group) have come up with some great uses for them:

- **Project memo**—record your goals, assumptions and key decisions. Like a journal, update it regularly and include links to the significant theme nodes and sources. Bring your journal to life by displaying it in a project map.

- **Interview or participant memo**—summarize the key points of an interview. Make note of contradictions, surprises or early hunches. Include ideas about the theme nodes you might make and include photos or descriptive information about the interview setting.

- **Node memo**—explain why you think a theme is significant (especially useful in team projects). Add to the memo as your thinking evolves and include links to the related literature. By writing as you go, you won’t face the pressure of staring at a blank document when it comes to writing up your project.

- **Query results memo**—what do these query results tell me? Make a memo to organize your ideas and to plan future steps. If you display your query results in a chart or other visualization, copy and paste it into the memo.

- **Analytical and procedural memos**—record your findings in analytical memos and use procedural memos to document the methodological steps you take.

- **NVivo memo**—record what works best in the software, including any tips or shortcuts you want to remember. Include links to NVivo-related support materials that you’ve found on the web.
Summarize your data in framework matrices

You can use framework matrices to summarize your data in a grid format—this is especially useful if you are working with interview or focus group transcripts.

The grid has rows for case nodes (for example, people you interviewed) and columns for theme nodes—you can enter your summary in the cells where the case and theme intersect. For example, you could summarize Anna’s experience of volunteering:

Working with condensed source materials in the framework matrix can make it easier to:

- See everything about a theme by looking down a column.
- See how different themes relate to each other for a particular individual by looking across a row.
- Compare the experiences of different individuals by comparing one row to another.

Once you have condensed your source materials in a framework matrix, you can easily share your data with others by printing the matrix or exporting the matrix to a spreadsheet.

Before you can start working with framework matrices, you need to import your source materials, code source content to case nodes, and set up thematic node hierarchies. Refer to the NVivo Help for comprehensive information about working with framework matrices.
Bring it all together with queries

You can use NVivo queries to:

- Find and analyze the words or phrases in your sources, theme nodes, cases and relationships. You can find specific words or those that occur most frequently.
- Ask questions and find patterns based on your coding, check for coding consistency among team members and review your progress.

You can work with queries using the **Query** tab:

Easily create queries using the step-by-step Query Wizard

Use queries for text analysis

You can explore the text in your sources using the following queries:

- **Text Search Query**: search for a word or phrase in your source material and view all the matches in a preview node—automatically code the content (if you want to). Display a word tree to visualize words in context:
• **Word Frequency Query**: list the most frequently occurring words in your sources and visualize the results in a word cloud, tree map or cluster analysis diagram:

![Word Frequency Query Result](image)

Display results in a word cloud
Double-click a word to view all occurrences

**Use queries to explore your coding**

You can review and explore your coding using:

• **Coding Query**: gathers all the coding at any combination of nodes—for example, gather and explore all content coded at water quality and tourism, or find where content coded at water quality is near content coded at tourism.

• **Matrix Coding Query**: creates a matrix of nodes based on search criteria. For example, show me attitudes about water quality by community.

• **Coding Comparison Query**: compares the coding of two researchers or two groups of researchers. This is useful for teams who are interested in coding consistency and the questions posed by researcher disagreement.

• **Compound Query**: combines text and coding queries—search for specified text in or near coded content.

• **Group Query**: finds items that are associated in a particular way with other items in your project. For example, list the theme nodes that code a selection of sources.
Making the most of queries

• Start running queries early on in the coding process—they can help you focus on the questions you want to ask (and prompt you to code accordingly). For example, if you want to ask “How serious are the issues of water quality for local fishermen?”—make sure you code at the theme node for water quality and code at case nodes with the fisherman attribute.

• Use coding queries to build-up and test ideas. For example, you have a hunch that people’s perception of water quality is closely tied to the pace of development. Create a query to gather all material coded at water quality where it is NEAR content coded at ‘development’.

• Use matrix coding queries to compare attitudes based on demographic attributes. For example, explore attitudes about water quality by community:

<table>
<thead>
<tr>
<th>Community</th>
<th>A: Positive</th>
<th>B: Mixed</th>
<th>C: Negative</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atlantic</td>
<td>10</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>Bettes (Strait)</td>
<td>13</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>Cedar Island</td>
<td>4</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>Davis</td>
<td>6</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>Gloucester (Strait)</td>
<td>13</td>
<td>0</td>
<td>4</td>
</tr>
</tbody>
</table>

Double click a cell to see the coded content

• Make a memo to record what you learn from a query—this can prompt you to ask further questions and facilitate deeper analysis. Link the memo to the query results.
**Visualize your project**

NVivo lets you explore your data using charts, maps, diagrams and other visualization techniques. They can help you to explore trends, test theories and make sense of what is happening in your source materials.

Create charts, maps and diagrams using options on the **Explore** tab:

<table>
<thead>
<tr>
<th>ANALYZE</th>
<th>QUERY</th>
<th>EXPLORE</th>
<th>LAYOUT</th>
<th>VIEW</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mind Map</td>
<td>Project Map</td>
<td>Concept Map</td>
<td>Chart</td>
<td>Cluster Analysis</td>
</tr>
<tr>
<td>Maps</td>
<td></td>
<td></td>
<td>Hierarchy Chart</td>
<td>Comparison Diagram</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Explore Diagram</td>
</tr>
</tbody>
</table>

**Generating diagrams**

Diagrams are illustrative tools that are generated based on your project data—a quick and easy way to represent your data visually.

- **Charts**: Create a chart to present or explore the data in your project. For example, to see the theme nodes that code a source. You can create a chart using the Chart Wizard or while working on other areas of your project—for example, you can make a chart based on a node, case, node matrix or source that you have opened in Detail View.
• **Cluster analysis diagram**: Group sources, theme nodes or cases that share similar words, attribute values, or coding.

![Cluster analysis diagram](image)

Click the Summary tab to see the values that were used to generate the diagram.

• **Tree map diagram**: Use a tree map to compare nodes by the number of references they contain. See patterns of coding in your project, or compare sources or nodes based on their attribute values.

![Tree map diagram](image)
As you work with sources, nodes or query results you can choose to visualize the data. For example, you can display a cluster analysis diagram for a social media dataset or display a word cloud for the results of a Word Frequency query.

Refer to the NVivo Help for more information about working with visualizations.

- **Comparison diagram**: Generate a comparison diagram to compare two cases to see what they have in common:

- **Explore diagram**: Generate an explore diagram to show all of the items connected to a single project item. The power of this diagram is that it is dynamic, allowing you to step forward and back through your project data to explore the connections between items:

As you work with sources, nodes or query results you can choose to visualize the data. For example, you can display a cluster analysis diagram for a social media dataset or display a word cloud for the results of a Word Frequency query.

Refer to the NVivo Help for more information about working with visualizations.
Building maps

Unlike diagrams (that NVivo builds for you), maps allow you to construct the visualization yourself. Create maps at any stage of your project—from developing your research question, through analysis and developing theory to presentation of results.

- **Mind map**: Brainstorm ideas and visualize your thoughts. Once you’ve created a mind map, you can automatically turn your ideas into theme nodes.

- **Concept map**: Define concepts, think through their connections and explore and present the connections in your theories:

![Concept map example](image-url)
• **Project map**: Create a project map to visualize the connections between project items. For example, you could see which items are connected to a particular source:
Create reports and extracts

As your project grows you can use reports to:

- Review and revise your progress
- Identify themes that are occurring more than others
- Present your findings

Extracts allow you to export a collection of your data to a text, Excel or XML file—you can use this data for complementary analysis in other applications.

To run one of NVivo’s predefined reports:

1. In Navigation View, click Reports, and then click the Reports folder.
2. In List View, double-click the report you want to run.

The report results are displayed in Detail View.

To create your own report—on the Explore tab, in the Reports group, click the New Report image. Follow the steps in the Report Wizard to choose the fields, filters and layout of your report. You can also create your own report (or modify an existing one) using the Report Designer—refer to the NVivo Help for more information about working with reports.
Automated insights

Automatically detect and codes themes and sentiment in your sources to gain quick insight into your data.

Use automated insights when you have limited time or large sets of data to develop preliminary results at the start of a project, or validate your thinking as you work.

The automated insights functionality enables you to do approximate ‘broad-brush’ coding of large volumes of text quickly, which you can then review and refine.

You do not need to have an understanding of data mining, text analytics or statistical methods and their terminology. There is no need to build up categories or criteria prior to running the analysis.

You can choose to auto code your sources for themes or sentiment.

---

Themes are identified and content is coded at resulting theme nodes...

...or sentiment is identified and content is coded at sentiment nodes

Choose a survey dataset or select a set of text sources

Run the sources through the Auto Code Wizard
**Auto code themes**

Quickly discover patterns or trends in your source material to answer the question *What are the key themes in my source material?*

Auto coding themes will assign a broad categorization to your data and provide some initial building blocks for you to work with.

Themes are identified by analyzing each source—the process detects noun phrases (for example, *water quality*) and counts their mentions. NVivo assigns significance to some themes over others based on how frequently each theme occurs across the set of sources being analyzed.

Themes are combined into groups and results are presented as a node for each broad idea, with child nodes for each theme within that group.

NVivo actively filters the themes—only the most relevant themes are presented in the results. You can choose which themes to create as nodes at the end of the process.
Auto code sentiment

Quickly identify expressions of sentiment in your content to find out *Is the general tone of my content positive or negative?*

Text analytics is a complex process and human perception of sentiment is always going to be more accurate. The process uses a scoring system. Each word containing sentiment has a pre-defined score. Content is coded to a set of sentiment nodes, ranging from very positive to very negative.

This process looks at the sentiment of words in isolation—the context is not taken into account. Therefore, it is possible to have the same sentence coded at positive and negative sentiment nodes. You can easily identify content coded at multiple nodes by running a **coding query.**

You can manually change the sentiment coding if you need to. It’s easy to reassign coding from one sentiment to another.

Once you have detected sentiment in your sources, auto code the same sources for themes and then run a **matrix coding query** to discover the general sentiment towards an issue.

Refer to the [NVivo Help](https://www.qsrinternational.com) for more information about automated insights.
Social Network Analysis

Social network analysis focuses on the links between people or other social entities. Use sociograms to visualize the connections in your social networks.

- Create an egocentric sociogram or network sociogram based on the relationships between cases in your project.
- Use NCapture to import a Twitter dataset and view a sociogram based on retweets and mentions between users.

Working with relationships

Create relationship nodes between the cases in your project to capture how they are connected. Choose a relationship type to convey the direction of the connection.

- One way (Anna 'employs' Ken)
- Symmetrical (Anna is 'Facebook friends with' Ken)
- Associative (Anna 'has met' Ken)

Generating sociograms

Sociograms are a graphic representation of the social links between people or other entities. Use sociograms to explore networks and answer questions about social interdependence like Who are the influential people in this community? or How fast can this person reach everyone in the network?

- **Egocentric sociogram**: Visualize all the cases connected to one particular case (the ego)—represented as a star shape.
• **Network sociogram**: Visualize a group of cases to see how they are connected. This type of sociogram can include isolated cases.

• **Twitter sociogram**: Visualize your Twitter dataset from NCapture—to see the network of your Twitter users, and how they are connected by retweets and mentions.